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Contacting FarPoint Technologies, Inc.

If you discover a problem with either the software or the accompanying documentation, or if you would like to 
send us your thoughts about this product, please send us a completed comment form.

Send us the comment form using one of the following methods, or if you call, please provide the information 
requested on the form to our technical support representative. For additional assistance, contact our Technical 
Support department.

To contact FarPoint Technologies, Inc.
Call our Technical Support department at (919) 460-1887.

FarPoint Technologies' Technical Support department is available between the hours of 9:00 a.m. and 5:30 
p.m. eastern time, Monday through Friday.

Note If you are using the trial installation, you are provided one support call to our Technical Support 
department. After you have used your one call, if you need additional technical support you may fax or
e-mail our Technical Support department.

Fax us at (919) 460-7606.
Visit our World Wide Web site (http://www.fpoint.com).
Send e-mail to us at 

- farpoint@fpoint.com (general mail)

- fpsupport@fpoint.com (technical support)

- fpdocs@fpoint.com (documentation).
Contact our FTP site (ftp://ftp.fpoint.com).
Write us at:

FarPoint Technologies, Inc.
175 Southport Drive
Suite 900
Morrisville, NC 27560



Installing Tab Pro

Use the installation program to install Tab Pro. If you receive an error message while running the installation 
program, exit Windows, restart it, and run the installation program again. If the installation program still returns an 
error message after you exit and restart Windows, call FarPoint Technologies' Technical Support department at 
(919) 460-1887 between the hours of 9:00 a.m. and 5:30 p.m. eastern time, Monday through Friday.

To Install Tab Pro from a Downloaded Trial Version

To Install Tab Pro from the FarPoint Products CD

To Install Tab Pro Manually from the FarPoint Products CD

Tab Pro Installed Files 



Tab Pro 3.0 Installed Files

If you choose the default installation, the Tab Pro installation program copies the following files into your Windows 
system directory (for example, \WINDOWS\SYSTEM). The installation program also creates \TABPRO30 and \
FARPOINT\REDIST directories on your hard disk and copies into them several subdirectories and files. The 
following table lists the files added to your Windows system directory and to the created directories. Items marked
with an asterisk (*) are not installed by the trial installation.

Directory Files Installed Description
Your Windows system 
directory

TABPRO30.HLP Help file

 TABPRO30.CNT Help contents
MFC42.DLL Microsoft Foundation Class library file
MSVCRT.DLL C run-time libraries
MSVCRT40.DLL C run-time libraries (not installed in Windows 

NT systems; file is already present)

\TABPRO30 INSTALL.LOG Log file created by installation
TABDEMO.HTM File that provides links to run provided samples
TPTITLE.JPG Picture file (displayed in TABDEMO.HTM)
TREADME.HLP Read Me Help File (this file)
UNWISE.EXE Uninstall program

\TABPRO30\BIN FPTAB30.OCX Tab 32-bit ActiveX control with ADO support
FPTAB30.DEP Dependency file for use with Visual Basic Setup

Wizard
TAB32D30.DLL* Tab 32-bit DLL control
TAB32X30.OCX Tab 32-bit ActiveX control with DAO support
TAB32X30.DEP Dependency file for use with Visual Basic Setup

Wizard
IMP32D30.DLL* Imprint 32-bit DLL control
IMP32X30.OCX Imprint 32-bit ActiveX control with DAO and 

ADO support
IMP32X30.DEP Dependency file for use with Visual Basic Setup

Wizard

\TABPRO30\DOCS TAB3UG.PDF* User's Guide in PDF format

\TABPRO30\INCLUDE TABPRO.BAS Constants for Visual Basic®
TABPRO.H C function prototypes
TABDLL.H C constant definitions
TABPMFC.CPP C++ implementation
TABPMFC.H C++ declarations for MFC users
TABPOWL.H C++ declarations for OWL users

\TABPRO30\LIB\BC IMP32D30.LIB* Imprint control DLL library (32-bit) for Borland
TAB32D30.LIB* Tab control DLL library (32-bit) for Borland

\TABPRO30\LIB\MS IMP32D30.LIB* Imprint control DLL library (32-bit) for Microsoft
TAB32D30.LIB* Tab control DLL library (32-bit) for Microsoft

\TABPRO30\SAMPLES Contains sample applications for different 
development environments 
(DLL control samples are not provided with the 
trial installation.)

\FARPOINT\REDIST MSVCRT40.DLL C run-time libraries

Tab Pro 3.0 Release Notes
New Features in Tab Pro 3.0
Release Notes



Notes for Beta Users



Additional Information for C and C++ Users

Using Tab Pro 32-Bit DLL Controls in Borland® C

Using Tab Pro ActiveX Controls in MSVC 4.0

Using Tab Pro ActiveX Controls in MSVC 5.0 



Using Tab Pro ActiveX Controls in MSVC 5.0

To use Tab Pro ActiveX controls in MSVC 5.0, you must generate a wrapper class for the control.

To generate a wrapper class, you must use an existing application that supports ActiveX controls, or you must 
create such an application.

Complete the steps in the following section to create an application that supports ActiveX controls. If you already 
have such an application, proceed to the section Generating a C++ Wrapper in MSVC 5.0.

Creating a New Application That Supports ActiveX Controls

To generate a new application that supports ActiveX controls

1. In MSVC 5.0, choose New from the File menu.

2. In the New dialog box, on the Projects tab,

a. Choose MFC AppWizard (exe).

b. Provide the project file name and path.

c. Choose the OK button.

3. In the MFC AppWizard - Step 1 dialog box, choose the Finish button. This accepts the defaults for all choices.

4. In the New Project Information dialog box, choose the OK button. 

MSVC 5.0 generates an application that supports ActiveX controls.

Generating a C++ Wrapper in MSVC 5.0
There are two methods for generating C++ wrappers in MSVC 5.0. You can place the control on a dialog, or you 
can add the control as an application component.

To generate a C++ wrapper with the control on a dialog

1. Open an existing dialog or create a new dialog in MSVC 5.0. 

To create a new dialog, select Resource from the Insert menu. Then, in the Insert Resource dialog box, select
Dialog from the Resource type list, and then choose the New button.

2. Click the right mouse button in the dialog to display the pop-up menu.

3. Choose Insert ActiveX Control.

4. In the Insert ActiveX Control dialog box, 

a. Select FarPoint TabPro 3.0 or FarPoint ImprintPro 3.0 from the ActiveX control list.

b. Choose the OK button.

5. Click the right mouse button in the dialog to display the pop-up menu.

6. Choose ClassWizard.

7. If you are creating a new dialog, create a C++ class for the dialog using the following steps:

a. In the Adding a Class dialog box, choose the OK button.

b. In the New Class dialog box under Class Information, type the new name in the Name box.

c. Choose the OK button.

8. Create a member variable for the control you inserted into your dialog using the following steps:

a. In the MFC ClassWizard window on the Member Variables tab, select the control ID of the ActiveX 
control you added to the dialog from the Control IDs list.

b. Choose the Add Variable button.

c. Choose the OK button in the Microsoft Developer Studio message that explains that a class wrapper will 
be generated for you.

9. In the Confirm Classes dialog box, you can modify the class name, the implementation file name, and the 
declaration header file name or accept the defaults provided.



10. Choose the OK button.

11. In the Add Member Variable dialog box, type a variable name in the Member variable name box, and then 
choose the OK button.

12. Choose the OK button.

ClassWizard generates a wrapper class to support the Tab Pro controls.

To generate a C++ wrapper with the control as an application component

1. In MSVC 5.0, from the Projects menu, choose Add to Project, Components and Controls.

2. In the Components and Controls Gallery dialog box, choose the Registered ActiveX Controls folder.

3. Select FarPoint Tab Pro 3.0 or FarPoint ImprintPro 3.0 from the list.

4. Choose the Insert button, then choose OK to insert the component.

5. In the Confirm Classes dialog box, 

a. Modify the class name, the implementation file name, and the declaration header file name or accept the
defaults provided.

b. Choose the OK button.

6. In the Components and Controls Gallery dialog box, choose the Close button.

ClassWizard generates a wrapper class to support the Tab Pro controls.



Documentation

Tab Pro 3.0 provides a printed and online version of the User's Guide and an online version of the Reference 
Guide.

User's Guide
The User's Guide is included in the online help file, and for licensed users, it is provided as a PDF file. To 
view the PDF version of the User's Guide, you must use Adobe® Acrobat® Reader 3.0. You can download 
the Acrobat Reader free of charge from the Adobe web site (www.adobe.com). The PDF version of the User's
Guide is not provided with the trial installation.

If you would like a printed version of the User's Guide, you can purchase a printed copy if you unlock and 
purchase Tab Pro from the trial version or buy Tab Pro electronically and you do not receive a software 
package. To do so, please call our sales department at (800) 645-5913 or (919) 460-4551 between 9 a.m. 
and 5:30 p.m. eastern time, Monday through Friday.
Reference Guide

The Reference Guide is included in the online help file. If you are using Windows 95, Windows NT (version 
4.0 or later), or Windows 98, you can print the online Reference Guide topics from the Contents page in the 
online help.

To print the online Reference Guide

1. Display the Contents page by running the online help file, or if it is already running, by clicking the 
Contents button.

2. Select the book labeled Reference Guide.

3. Click the Print button.

4. In the Print dialog box, change the settings as you require, then click the OK button.

The topics listed under the Reference Guide book are sent to the specified printer.



Tab Pro 3.0 Comment Form

If you encounter a problem with this product, or if you would like to share your comments with FarPoint 
Technologies, please complete and send this form to FarPoint Technologies. Contact us using one of the methods
listed in Contacting FarPoint Technologies, Inc.

If you are reporting a problem, please include a detailed description of the problem along with the steps 
necessary to reproduce it. The preferred method is a sample application that reproduces the problem. f you have 
a sample, please send it to our Internet address (fpsupport@fpoint.com or FTP to ftp://ftp.fpoint.com); please be 
sure to include the name of the .ZIP file.

Today's date: ___________________

Customer name: _________________________ Company name: ___________________________

Phone number: (_____)____________________ Fax number: (_____)________________________

E-mail address: __________________________ Sample application file name: ________________

Control or controls used in application (circle one or both): Imprint Tab

Version Number: Tab Pro 3.0 Control Date: _________________

Control Type (circle one or more): 32-bit DLL ActiveX ActiveX (ADO)

Development environment: _________________________ Version: ______
(for example, Visual Basic, Visual C++, Borland C++)

Description of the problem:

Steps necessary to reproduce the problem:

Comments/Documentation suggestions:



Using Tab Pro 3.0 DLL Controls in Borland C

To use Tab Pro 3.0 DLL controls in Borland C, you must use version 5.0 or greater of Borland C's IMPLIB.EXE to 
generate a valid TAB32D30.LIB or IMP32D30.LIB. The IMPLIB command does not generate a backward-
compatible library for earlier versions of Borland C (that is, for versions previous to version 5.0).



Using Tab Pro ActiveX Controls in MSVC 4.0

To use Tab Pro ActiveX controls in MSVC 4.0, you must generate wrapper classes for the controls.

To generate a wrapper class, you must use an existing application that supports OLE controls, or you must create
such an application.

Complete the steps in the following section to create an application that supports OLE controls. If you already 
have such an application, proceed to the section Generating a C++ Wrapper for Tab Pro Controls in MSVC 4.0.

Creating a New Application That Supports OLE Controls

To generate a new application that supports OLE controls

1. In MSVC 4.0, choose New from the File menu.

2. In the New dialog box, select Project Workspace from the New list.

3. Choose the OK button.

4. In the New Project Workspace dialog box,

a. Select the default item (MFC AppWizard (exe)) from the Type list.

b. Type a project name into the Name box.

c. Type a location for your project files in the Location box or choose the Browse button to select a drive 
and directory.

d. Choose the Create button.

5. In the MFC AppWizard - Step 1 dialog box, choose the Next button.

6. In the MFC AppWizard - Step 2 of 6 dialog box, choose the Next button.

7. In the MFC AppWizard - Step 3 of 6 dialog box, select the OLE controls check box and choose the Finish 
button. 

This accepts the defaults for all other choices.

8. In the New Project Information dialog box, choose the OK button and MSVC 4.0 generates an application 
that supports OLE controls.

Generating a C++ Wrapper for Tab Pro Controls in MSVC 4.0
There are two methods for generating C++ wrappers in MSVC 4.0. You can place the control on a dialog, or you 
can add the control as an application component.

To generate a C++ wrapper with the control on a dialog

1. Open an existing dialog or create a new dialog in MSVC 4.0. To create a new dialog, select Resource from 
the Insert menu. Then, in the Insert Resource dialog box, select Dialog from the Resource type list, and then 
choose the OK button.

2. Click the right mouse button in the dialog to display the pop-up menu.

3. Choose Insert OLE Control.

4. In the Insert OLE Control dialog box, select either FarPoint TabPro 3.0 or FarPoint ImprintPro 3.0 from the 
OLE control list.

5. Choose the OK button.

6. Click the right mouse button in the dialog to display the pop-up menu.

7. Choose ClassWizard.

8. If you are creating a new dialog, create a C++ class for the dialog using the following steps:

a. In the Adding a Class dialog box, choose the OK button.

b. In the Create New Class dialog box under Class Information, type the new name in the Name box.

c. Choose the Create button.



9. Create a member variable for the control you inserted into your dialog using the following steps:

a. In the MFC ClassWizard window on the Member Variables tab, select the control ID of the OLE control 
you added to the dialog from the Control IDs list.

b. Choose the Add Variable button.

c. Choose the OK button in the Microsoft® Developer Studio message that explains that a class wrapper 
will be generated for you.

10. In the Confirm Classes dialog box, you can modify the class name, implementation file name, and the 
declaration header file name or accept the defaults provided.

11. Choose the OK button.

12. In the Add Member Variable dialog box, type a variable name in the Member variable name box.

13. Choose the OK button.

ClassWizard generates a wrapper class to support the selected Tab Pro 3.0 control.

To generate a C++ wrapper with the control as an application component

1. In MSVC 4.0, choose Component from the Insert menu.

2. In the Component Gallery dialog box, choose the OLE Controls tab.

3. Select either FarPoint TabPro 3.0 or FarPoint ImprintPro 3.0 from the list.

4. Choose the Insert button.

5. In the Confirm Classes dialog box, you can modify the class name, implementation file name, and the 
declaration header file name or accept the defaults provided.

6. Choose the OK button.

7. In the Component Gallery dialog box, choose the Close button.

ClassWizard generates a wrapper class to support the selected Tab Pro 3.0 control.



Upgrading Existing Projects to Use Tab Pro 3.0

The following topics provide information and instructions about upgrading existing projects containing Tab and 
Imprint controls to use the Tab Pro version 3.0.

If you have comments or questions about these upgrade instructions, please contact us using the methods listed 
in Contacting FarPoint Technologies, Inc.

Upgrading Projects that Used Tab Pro 2.0

Upgrading Visual Basic Projects
Tab Pro 2.0 VBX to Tab Pro 3.0 ActiveX (DAO)
Tab Pro 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO)
Converting Visual Basic Projects that Use the 2.0 ActiveX Control to Use the 3.0 ADO ActiveX Control

Upgrading C++ Projects
Tab Pro 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO)
Tab Pro 2.0 DLL to Tab Pro 3.0 DLL

Upgrading C Projects
Tab Pro 2.0 DLL to Tab Pro 3.0 DLL

Upgrading Projects that Used Tab 2.0

Upgrading Visual Basic Projects
Tab 2.0 VBX to Tab Pro 3.0 ActiveX (DAO)
Tab 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO)

Upgrading C++ Projects
Tab 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO)

Upgrading Projects that Used Tab Pro 1.x

Upgrading Visual Basic Projects
Tab Pro 1.  x   VBX to Tab Pro 3.0 ActiveX (DAO)  

Upgrading C++ Projects
Tab Pro 1.  x   DLL to Tab Pro 3.0 DLL  

Upgrading C Projects
Tab Pro 1.  x   DLL to Tab Pro 3.0 DLL  

Upgrading Projects that Used Tab/VBX

Upgrading Visual Basic Projects
Tab/VBX VBX to Tab Pro 3.0 ActiveX (DAO)



Converting Visual Basic Projects that Use the Tab Pro 2.0 ActiveX Control to Use the Tab 
Pro 3.0 ADO ActiveX Control

You cannot upgrade existing projects to use the Tab Pro 3.0 ADO ActiveX control, but you can convert them by 
completing the following steps. The process involves converting your project to use the DAO ActiveX control, and 
then converting again to use the ADO ActiveX control. You will have to re-create your data binding setup using the
ADO Data Control and the ADO ActiveX control.

If you formerly used the Tab Pro version 2.0 16-bit or 32-bit ActiveX control and now want to use the version 3.0 
ADO ActiveX control (32-bit), complete the following steps.

1. Start Visual Basic 6.0 and open your existing project.

2. When Visual Basic prompts you to upgrade your control to the Tab Pro 3.0 control, choose Yes. 

3. Run your project.

4. Stop your project, save it, and close Visual Basic 6.0.

5. Open your project file (.MAK or .VBP) in a text editor and change the following:
If the project used the file TABPRO.BAS, change the path to use the updated TABPRO.BAS file instead. If 

you chose the default installation, the updated file is in \Program Files\TabPro30\Include.
Change the following reference:

Change:

Object={48932A52-981F-101B-A7FB-4A79242FD97B}#3.0#0; TAB32X30.OCX

To:

Object={F7E69521-3C28-11D2-B3E7-00AA00B42B7C}#3.0#0; FPTAB30.OCX

When finished, save your changes and close the project file.

6. Open your form files (.FRM) in a text editor and change the following reference:

Change:

Object = "{48932A52-981F-101B-A7FB-4A79242FD97B}#3.0#0"; "TAB32X30.OCX"

To:

Object = "{F7E69521-3C28-11D2-B3E7-00AA00B42B7C}#3.0#0"; "FPTAB30.OCX"

You will also need to change the class name in the .FRM file as follows:

Change . . . To . . .      

TabproLib.vaTabPro TabproADOLib.fpTabProADO

When finished, save your changes and close the form files.

7. Start Visual Basic 6.0 and open your project.

8. When Visual Basic 6.0 gives you a warning that "No compatible data source was found for this control." 
because the project does not contain an ADO data source, choose OK to continue.

9. Delete the DAO data control from your forms.

10. Add the Microsoft ADO Data Control 6.0 (OLEDB) to your project.

11. Place the Microsoft ADO Data Control 6.0 (OLEDB) on your forms as needed.

12. Set up the data binding for the Microsoft ADO Data Control 6.0 (OLEDB).

13. Change the DataSource property for your ADO Tab control to the name of the Microsoft ADO Data Control 
6.0 (OLEDB) and set the DataField property to the name of the database field to display.



Color Settings in Tab Pro 3.0

Tab Pro 3.0 has changed the default value of several color settings to use system colors rather than fixed color 
settings. The following tables list the color settings for the Tab and Imprint controls, and explain the changes 
between Tab Pro 2.0 settings and Tab Pro 3.0 settings.

Tab Control
Property Name Tab Pro 2.0 default Tab Pro 3.0 default
BackColor &H00C0C0C0& (light gray) &H8000000F& (Windows system button face color)
BookColor &H00808080& (dark gray) no change
BookCornerGuardColor &H0000C0C0& (gold) no change
BookCornerGuardColorDark &H00008080& (brown) no change
BookCornerGuardColorLight &H0000FFFF& (yellow) no change
BookCreaseColor &H00C0C0C0& (light gray) no change
BookMetalSpineColor &H00808080& (dark gray) no change
BookMetalSpineOutlineColor &H00000000& (black) no change
BookRingColor &H00C0C0C0& (light gray) no change
BookRingColorLight &H00FFFFFF& (white) no change
BookRingColorOutline &H00000000& (black) no change
BookShadowColor &H00000000& (black) no change
EarMarkColorDark &H00C0C0C0& (light gray) &H8000000F& (Windows system button face color)
EarMarkColorLight &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)
EarMarkColorOutline &H00808080& (dark gray) &H80000010& (Windows system button shadow color)
EarMarkPictureMaskColor not applicable &H00FF00FF& (pink)
ForeColor &H00000000& (black) &H80000012& (Windows system button text color)
GrayAreaColor &H00C0C0C0& (light gray) &H8000000F& (Windows system button face color)
OutlineColor &H00000000& (black) no change
PageColor TAB_COLOR_NONE &H8000000F& (Windows system button face color)
PageEarMarkColorDark &H00C0C0C0& (light gray) &H8000000F& (Windows system button face color)
PageEarMarkColorLight &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)
PageEarMarkColorOutline &H00808080& (dark gray) &H80000010& (Windows system button shadow color)
PageEarMarkPictureMaskCol
or

not applicable &H00FF00FF& (pink)

TabPictureMaskColor not applicable &H00FF00FF& (pink)
ThreeDHighlightColor &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)
ThreeDInnerDark &H00808080& (dark gray) &H80000010& (Windows system button shadow color)
ThreeDInnerLight &H00C0C0C0& (light gray) &H80000014& (Windows system 3-D highlight color)
ThreeDOuterDark &H00000000& (black) &H80000015& (Windows system 3-D dark shadow color)
ThreeDOuterLight &H00FFFFFF& (white) &H80000016& (Windows system 3-D light color)
ThreeDShadowColor &H00808080& (dark gray) &H80000010& (Windows system button shadow color)
ThreeDTextHighlightColor &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)
ThreeDTextShadowColor &H00808080& (dark gray) &H80000010& (Windows system button shadow color)

Imprint Control
Property Name Tab Pro 2.0 default Tab Pro 3.0 default
BackColor &H00C0C0C0& (light gray) &H8000000F& (Windows system button face color)
ForeColor &H00000000& (black) &H80000012& (Windows system button text color)
FrameColor &H00C0C0C0& (light gray) &H8000000F& (Windows system button face color)
FrameThreeDHighlightColor &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)
FrameThreeDShadowColor &H00808080& (dark gray) &H80000010& (Windows system button shadow color)
OutlineInsideColor &H00000000& (black) &H80000012& (Windows system button text color)
OutlineOutsideColor &H00000000& (black) &H80000012& (Windows system button text color)
ThreeDHighlightColor &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)
ThreeDShadowColor &H00808080& (dark gray) &H80000010& (Windows system button shadow color)
ThreeDTextHighlightColor &H00FFFFFF& (white) &H80000014& (Windows system 3-D highlight color)



ThreeDTextShadowColor &H00808080& (dark gray) &H80000010& (Windows system button shadow color)

Tab Pro 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO) in Visual Basic

If you formerly used Tab Pro version 2.0 or later ActiveX controls and now want to use the version 3.0 ActiveX 
(DAO) controls, complete the following steps.

1. Open your project in Visual Basic 4.0 (32-bit), Visual Basic 5, or Visual Basic 6. When prompted to upgrade 
to use the Tab Pro version 3.0 controls, choose Yes. Alternatively, you can upgrade the controls manually, as 
explained in step 4.

2. Save the project and form files and close Visual Basic.

3. If the project used the file TABPRO.BAS, edit the project file (.MAK or .VBP) in a text editor to change the 
path to use the updated TABPRO.BAS file instead. If you chose the default installation, the updated file is in \
Program Files\TabPro30\Include.

4. If you were not prompted to upgrade the controls in step 1 or you chose not to upgrade them, you can do the 
following:

a. Edit the project file (.MAK or .VBP) in a text editor to change the following references, if present:

Change:

Object={48932A52-981F-101B-A7FB-4A79242FD97B}#2.0#0; TAB32X20.OCX

To:

Object={48932A52-981F-101B-A7FB-4A79242FD97B}#3.0#0; TAB32X30.OCX

Change:

Object={990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#2.0#0; IMP32X20.OCX

To:

Object={990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#3.0#0; IMP32X30.OCX

When finished, save your changes and close the project file.

b. If you are using Visual Basic 5 or 6, edit the form files (.FRM) in a text editor to change the following 
references, if present:

Change:

Object = "{48932A52-981F-101B-A7FB-4A79242FD97B}#2.0#0"; "TAB32X20.OCX"

To:

Object = "{48932A52-981F-101B-A7FB-4A79242FD97B}#3.0#0"; "TAB32X30.OCX"

Change:

Object = "{990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#2.0#0"; "IMP32X20.OCX"

To:

Object = "{990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#3.0#0"; "IMP32X30.OCX"

When finished, save your changes and close the form files.

5. Open your project in Visual Basic 4 (32-bit), Visual Basic 5, or Visual Basic 6 and verify that the project uses 
the updated files.

6. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.



Tab Pro 2.0 VBX to Tab Pro 3.0 ActiveX (DAO) in Visual Basic

If you formerly used Tab Pro version 2.0 or later VBX controls and now want to use Tab Pro version 3.0 ActiveX 
controls, complete the following steps:

1. If your existing project and form files have been saved as text, proceed to step 2. If they have not been saved
as text, open them in Visual Basic 3.0 or 4.0 (16-bit) and change the project setting to save them as text. 
Save them, and then close Visual Basic.

2. Open your project file (.MAK or .VBP) in a text editor and if the project used the file TABPRO.BAS, change 
the path to use the updated TABPRO.BAS file instead. If you chose the default installation, the updated file is 
in \Program Files\TABPRO30\INCLUDE.

When finished, save your changes and close the project file.

3. Start Visual Basic 4 (32-bit), Visual Basic 5, or Visual Basic 6 and open your project file.

4. When the Custom Control Upgrade dialog prompts you to upgrade the TABPRO20.VBX or IMPPRO20.VBX, 
choose the OK button.

5. Respond to the Visual Basic messages. When prompted that your project will be saved to the newer version 
of Visual Basic, choose OK.

6. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.



Tab Pro 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO) in C++

If you formerly used Tab Pro version 2.0 or later ActiveX controls and now want to use the version 3.0 ActiveX 
(DAO) controls, complete the following steps.

1. Open your existing project in Visual C++.

2. Remove the .CPP and .H wrapper files for the control(s) (if applicable), and then delete them from your 
system.

3. From the Project menu choose Add To Project->Components and Controls and add the new version of the 
Tab Pro control(s). 

Make sure the new class and file names are the same as the old ones; this eliminates any need for coding 
changes.

4. If you added an Tab Pro ActiveX control to a dialog, open the .RC file as text and change the CLSID in the 
control statement to reflect the new control:
Control Change CLSID from . . . To Tab Pro 3.0 CLSID . . .
fpTab 48932A4F-981F-101B-A7FB-4A79242FD97B 3498C972-FC11-11D2-A05D-00A0C90DC755
fpImprint 990AFBE0-7E6C-101C-A7FD-4A79242FD97B FEA8A0B2-2E5B-11D3-A06C-00A0C90DC755
For example, for the Tab control, 

Change:
CONTROL         "",IDC_TABCTRL1,"{48932A4F-981F-101B-A7FB-4A79242FD97B}", 
WS_TABSTOP,13,12,83,32
To:
CONTROL         "",IDC_TABCTRL1,"{3498C972-FC11-11D2-A05D-00A0C90DC755}", 
WS_TABSTOP,13,12,83,32

5. Review the information in New Features in Tab Pro 3.0 to determine if you want to update other settings in 
your project.

6. Rebuild your project and run it.



Tab Pro 2.0 DLL to Tab Pro 3.0 DLL in C++

If you formerly used Tab Pro version 2.0 or later DLL controls and now want to use Tab Pro version 3.0 32-bit DLL 
controls, complete the following steps.

1. Open your existing project in a 32-bit compiler

If your existing project was a 16-bit project, let the conversion change it to a 32-bit project.

2. Replace TABPMFC.CPP file in your project with the new versions of this file.

3. Change the following references in your project as necessary:
Change . . . To . . . 
IMP16D20.LIB IMP32D30.LIB
TAB16D20.LIB TAB32D30.LIB

4. If your project used the AutoSizeChildren property, remove that property from your project, because it is not 
supported for DLL controls.

5. If you used the user-defined resource control to add a Tab Pro control to a dialog, open the .RC file as text in 
a text editor and make the following changes:

Change . . . To . . .
fpTabPro3220 fpTabPro3230
fpImprintPro3220 fpImprintPro3230

or
Change . . . To . . .
fpTabPro1620 fpTabPro3230
fpImprintPro1620 fpImprintPro3230

6. Change the .DLL the project loads as shown in the following tables.
Change . . . To . . .
TAB32D20.DLL TAB32D30.DLL
IMP32D20.DLL IMP32D30.DLL

or
Change . . . To . . .
TAB16D20.DLL TAB32D30.DLL
IMP16D20.DLL IMP32D30.DLL

7. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.

8. Rebuild your project and run it.



Tab 2.0 VBX to Tab Pro 3.0 ActiveX (DAO) in Visual Basic

If you formerly used Tab version 2.0 or later VBX controls and now want to use Tab Pro version 3.0 ActiveX 
controls, complete the following steps:

1. If your existing project and form files have been saved as text, proceed to step 2. If they have not been saved
as text, open them in Visual Basic 3.0 or 4.0 (16-bit) and change the project setting to save them as text. 
Save them, and then close Visual Basic.

2. Open your project file (.MAK or .VBP) in a text editor and if the project used the TAB.BAS file, change the 
path and file name to use the TABPRO.BAS file instead. If you chose the default installation, the updated file 
is in \Program Files\TABPRO30\INCLUDE.

When finished, save your changes and close the project file.

3. Open your form files (.FRM) in a text editor and change the following references, if present:
Change . . . To . . .
vaTab vaTabPro
fpVbImprint vaImprint
When finished, save your changes and close the form files.

4. Start Visual Basic 4 (32-bit), Visual Basic 5, or Visual Basic 6 and open your project file.

5. When the Custom Control Upgrade dialog prompts you to upgrade the FPTAB20.VBX or IMPPRO20.VBX, 
choose the OK button.

6. Respond to the Visual Basic messages. When prompted that your project will be saved to the newer version 
of Visual Basic, choose OK.

7. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.



Tab 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO) in Visual Basic

If you formerly used Tab version 2.0 or later Tab ActiveX controls and now want to use the version 3.0 Tab ActiveX
(DAO) controls, complete the following steps.

1. Open your project in Visual Basic 4.0 (32-bit), Visual Basic 5, or Visual Basic 6. When prompted to upgrade 
to use the Tab Pro version 3.0 controls, choose Yes. Alternatively, you can upgrade the controls manually, as 
explained in step 4.

2. Save the project and form files and close Visual Basic.

3. If the project used the file TAB.BAS, edit the project file (.MAK or .VBP) in a text editor to change the path 
and file name to use the updated TABPRO.BAS file instead. If you chose the default installation, the updated 
file is in \Program Files\TabPro30\Include.

4. If you were not prompted to upgrade the controls in step 1 or you chose not to upgrade them, you can do the 
following:

a. Edit the project file (.MAK or .VBP) in a text editor to change the following references, if present:

Change:

Object={990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#2.0#0; IMP32X20.OCX

To:

Object={990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#3.0#0; IMP32X30.OCX

and

Change:

Object={8068B521-9C56-11CF-8BC4-00AA00B42B7C}#2.0#0; FPT32X20.OCX

To:

Object={48932A52-981F-101B-A7FB-4A79242FD97B}#3.0#0; TAB32X30.OCX

When finished, save your changes and close the project file.

b. If you are using Visual Basic 5 or 6, edit the form files (.FRM) in a text editor to change the following:
Change the following references, if present:

Change:

Object = "{990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#2.0#0"; "IMP32X20.OCX"

To:

Object = "{990AFBE3-7E6C-101C-A7FD-4A79242FD97B}#3.0#0"; "IMP32X30.OCX"

and

Change:

Object = "{8068B521-9C56-11CF-8BC4-00AA00B42B7C}#2.0#0"; "FPT32X20.OCX"

To:

Object = "{48932A52-981F-101B-A7FB-4A79242FD97B}#3.0#0"; "TAB32X30.OCX"
Change the Tab control's class name in the .FRM file as follows:

Change . . . To . . .      
vaTabLib.vaTab TabproLib.vaTabPro

When finished, save your changes and close the form files.

6. Open your project in Visual Basic 4 (32-bit), Visual Basic 5, or Visual Basic 6 and verify that the project uses 
the updated files.

7. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.



Tab 2.0 ActiveX to Tab Pro 3.0 ActiveX (DAO) in C++

If you formerly used Tab version 2.0 or later ActiveX controls and now want to use the version 3.0 ActiveX (DAO) 
controls, complete the following steps.

1. Open your existing project in Visual C++.

2. Remove the .CPP and .H wrapper files for the control(s) (if applicable), and then delete them from your 
system.

3. From the Project menu choose Add To Project->Components and Controls and add the new version of the 
Tab Pro control(s). 

Make sure the new class and file names are the same as the old ones; this eliminates any need for coding 
changes.

4. If you added a Tab ActiveX control to a dialog, open the .RC file as text and change the CLSID in the control 
statement to reflect the new control:
Control Change CLSID from . . . To Tab Pro 3.0 CLSID . . .
fpTab 8068B520-9C56-11CF-8BC4-00AA00B42B7C 3498C972-FC11-11D2-A05D-00A0C90DC755
fpImprint 990AFBE0-7E6C-101C-A7FD-4A79242FD97B FEA8A0B2-2E5B-11D3-A06C-00A0C90DC755
For example, for the Tab control, 

Change:
CONTROL         "",IDC_TABCTRL1,"{8068B520-9C56-11CF-8BC4-00AA00B42B7C}", 
WS_TABSTOP,13,12,84,33
To:
CONTROL         "",IDC_TABCTRL1,"{3498C972-FC11-11D2-A05D-00A0C90DC755}", 
WS_TABSTOP,13,12,83,32

5. Review the information in New Features in Tab Pro 3.0 to determine if you want to update other settings in 
your project.

6. Rebuild your project and run it.



Tab Pro 1.x DLL to Tab Pro 3.0 DLL in C++

If you formerly used Tab Pro version 1.x or later DLL controls and now want to use Tab Pro version 3.0 32-bit DLL 
controls, complete the following steps.

1. Open your existing project in a 32-bit compiler

If your existing project was a 16-bit project, let the conversion change it to a 32-bit project.

2. Replace TABPMFC.CPP file in your project with the new version of this file.

3. If your project references the .LIB files, make the following changes as necessary:

Change . . . To . . .      

IMPDLL11.LIB IMP32D30.LIB

TABDLL11.LIB TAB32D30.LIB

4. If your project used the AutoSizeChildren property, remove that property from your project, because it is not 
supported for DLL controls.

5. If you used the user-defined resource control to add a Tab Pro control to a dialog, open the .RC file as text in 
a text editor and make the following changes:

Change . . . To . . .
fpTabPro11 fpTabPro3230
fpImprintPro11 fpImprintPro3230

6. Change the .DLL the project loads as shown in the following tables.
Change . . . To . . .
TABDLL11.DLL TAB32D20.DLL
IMPDLL11.DLL IMP32D30.DLL

7. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.

8. Rebuild your project and run it.



Tab Pro 1.x DLL to Tab Pro 3.0 DLL in C

If you formerly used Tab Pro version 1.x or later DLL controls and now want to use Tab Pro version 3.0 32-bit DLL 
controls, complete the following steps.

1. Open your existing project in a 32-bit compiler

If your existing project was a 16-bit project, let the conversion change it to a 32-bit project.

2. If the project used the file TABDLL11.H, update the path to use the version 3.0 TABDLL.H file.

3. If your project references the .LIB files, make the following changes as necessary:

Change . . . To . . .      

IMPDLL11.LIB IMP32D30.LIB

TABDLL11.LIB TAB32D30.LIB

4. If you hard coded the class name of the Imprint or Tab control in your project, make the following changes:      

a. Either use the define (FPCLASS_IMPRINT for Imprint or FPCLASS_TAB for Tab) or

b. Make the following changes as needed:

Change . . . To . . .      

fpImprintPro11 fpImprintPro3230 (32-bit DLL)

fpTabPro11 fpTabPro3230 (32-bit DLL)

5. If your project is in MSVC 1.5.2 and used message identifier numbers rather than message defines, you must
update the message numbers using the new numbers listed in the header file, TABDLL.H, or using the 
defines listed in the same file. 

To avoid updating identifiers in future updates, use the message defines rather than the message identifier 
numbers when creating your projects.

6. Rebuild your project and run it.



Tab Pro 2.0 DLL to Tab Pro 3.0 DLL in C

If you formerly used Tab Pro version 2.0 or later DLL controls and now want to use Tab Pro version 3.0 32-bit DLL 
controls, complete the following steps.

1. Open your existing project in a 32-bit compiler

If your existing project was a 16-bit project, let the conversion change it to a 32-bit project.

2. If the project used the file TABDLL.H, update the path to use the version 3.0 TABDLL.H file.

3. Change the following references in your project as needed:

Change . . . To . . .      

IMP16D20.LIB IMP32D30.LIB

TAB16D20.LIB TAB32D30.LIB

4. If you hard coded the class name of the Imprint or Tab control in your project, make the following changes:

a. Either use the define (FPCLASS_IMPRINT for Imprint or FPCLASS_TAB for Tab) or

b. Make the following changes as needed:

Change . . . To . . .      

fpImprintPro1620 fpImprintPro3230 (32-bit DLL)

fpImprintPro3220 fpImprintPro3230 (32-bit DLL)

fpTabPro1620 fpTabPro3230 (32-bit DLL)

fpTabPro3220 fpTabPro3230 (32-bit DLL)

5. If your project is in MSVC 1.5.2 and used message identifier numbers rather than message defines, you must
update the message numbers using the new numbers listed in the header file, TABDLL.H, or using the 
defines listed in the same file. 

To avoid updating identifiers in future updates, use the message defines rather than the message identifier 
numbers when creating your projects.

6. Rebuild your project and run it.



New Features in Tab Pro 3.0
Tab and Imprint ActiveX controls support ActiveX Data Objects (OLE DB) data binding, as well as DAO and 

RDO data binding.
Tab Pro 3.0 ActiveX controls are apartment-threaded controls.
New properties for the Tab control:

EarMarkPictureMaskColor

EarMarkPictureNext

EarMarkPicturePrev

PageEarMarkPictureMaskColor

PageEarMarkPictureNext

PageEarMarkPicturePrev

PagePicture

Picture

PictureFill

TabPictureMaskColor
New property for the Imprint control:

Picture
Additional settings for the following existing Tab control properties:

AlignPictureV

AutoStyle

PageEarMarkType
New event:

ChildrenSized
New functions and methods for ActiveX controls:

TabEnumChildNames

TabEnumChildTags
New functions for DLL controls:

ImpGetPictureEx

ImpSetPictureEx

TabGetEarMarkPictureNextEx

TabGetEarMarkPicturePrevEx

TabGetPageEarMarkPictureNextEx

TabGetPageEarMarkPicturePrevEx

TabGetPagePictureEx

TabGetPictureEx

TabGetTabPictureEx

TabSetEarMarkPictureNextEx

TabSetEarMarkPicturePrevEx

TabSetPageEarMarkPictureNextEx

TabSetPageEarMarkPicturePrevEx

TabSetPagePictureEx

TabSetPictureEx

TabSetTabPictureEx
Design time support for setting pictures, plus metafile support.



Tab Pro 3.0 now uses system colors as defaults for some color property settings. For more information, see 
Color Settings in Tab Pro 3.0.

The Tab ActiveX control provides optimized intelligent scanning and loading of child controls.



Release Notes
Tab Pro 3.0 provides 32-bit ActiveX and DLL controls. Tab Pro 3.0 does not provide 16-bit OCX, VBX, and 

DLL controls.
If you have created applications using previous versions of Tab Pro or Tab/VBX, you must upgrade your 

existing projects. For upgrade instructions, refer to Upgrading Existing Projects to Use Tab Pro 3.
If you are using a Tab Pro control in either C or C++, refer to Additional Information for C and C++ Users for 

more information about using the controls.
To place child controls on your Imprint or Tab ActiveX controls at design time, your container must support 

ISimpleFrameSite. If your container does not support ISimpleFrameSite, you must add child controls at run time.
Caution  If you are applying an AutoStyle to your Tab control, to avoid losing property settings, apply the 

AutoStyle immediately after you create the Tab control and before you set other properties. If you have already 
changed characteristics of your Tab control, be aware that applying an AutoStyle may change those characteristics. 
Also, note that applying an AutoStyle to a Tab control that contains child controls may create unexpected results.

At design time in the Properties window or in the property pages, the AutoStyle property always has the 
value of 0 (Reset), even if you just applied an AutoStyle to the Tab control. The property retains this setting because 
the AutoStyle property represents a one-time action applied to the Tab control.

You cannot double-click a control in the toolbox to make it a child of an Imprint or Tab control. You must 
select the control, and then draw it in the Imprint or Tab control. If you double-click a control in the toolbox, it becomes
a child of the form; it does not become a child of the control with the focus.



Notes for Beta Users
Tab Pro Beta release 3.0.00 provided 16-bit VBX and DLL controls. After much thought and surveying our 

customers, we decided that Tab Pro version 3.0 will not offer 16-bit controls.
If you have questions about our decision to no longer offer 16-bit controls, please contact our Sales 
department at (800) 645-5913. FarPoint Technologies' Sales department is available between the hours of 
9:00 a.m. and 5:30 p.m. eastern time, Monday through Friday. Alternatively, you can send e-mail to 
fpsales@fpoint.com.
The following additional properties have been added since Beta release 3.0.00:

EarMarkPictureMaskColor

PageEarMarkPictureMaskColor
In Beta release 3.0.00, the PageEarMarkPictureNext and PageEarMarkPicturePrev properties were applied 

globally to the Tab control. In releases after 3.0.00, the PageEarMarkPictureNext and PageEarMarkPicturePrev 
properties are applied to the tab or tabs specified by the settings of the ApplyTo and Tab properties.

You might need to update your existing projects to account for that change.
The Beta release provided the TABM_CHILDRENSIZED message. That message has been removed from 

Tab Pro version 3.0. The Tab DLL control does not support sizing children automatically.



Redistributing Tab Pro Controls

If you are redistributing a Tab Pro control with your application, review the following information concerning the 
files you must distribute with your application.

ActiveX Controls 
DLL Controls 



ActiveX Controls

Before an ActiveX control can be used in your distributed application, it must be included in the Windows 
registration database. As a developer, you are responsible for registering the ActiveX control files, as well as any 
files noted below it. If the files are already present on the target system, they need not be registered.

Your setup program can register controls and files directly. Use the LoadLibrary Windows API to load the control's 
DLL or the DLL file, then use GetProcAddress to obtain the address of the "DLLRegisterServer" function, and then
call that function.

For additional information, consult your development environment's documentation.

Required Files

To redistribute Tab Pro 32-bit ActiveX controls, you must include the following files, based on your development 
environment:
File Description Provided in
FPTAB30.OCX* Tab 32-bit ActiveX control with ADO 

support OR
\TABPRO30\BIN

TAB32X30.OCX* Tab 32-bit ActiveX control with DAO 
support

\TABPRO30\BIN

IMP32X30.OCX* Imprint 32-bit ActiveX control \TABPRO30\BIN
MFC42.DLL*‡ Library file (version 6.0 or later) \Your Windows system directory
MSVCRT.DLL‡ C run-time libraries (version 6.0 or later) \Your Windows system directory
MSVCRT40.DLL† C run-time libraries \FARPOINT\REDIST
* Must be registered on target system.

† If you are developing your application in Visual C++ 4.0 or 4.1, you might need to redistribute this DLL. For more
information, refer to Microsoft Knowledge Base articles Q154591 and Q165282.

‡ You must use the specified version or later of this file in your installation. If you do not do so, your installation 
might fail or produce unexpected results.

Note If you are using Visual Basic's setup wizard to create your installation, check that the DLL files the wizard 
incorporates are the versions listed in the preceding table. The setup wizard pulls DLL files for the 
installation it creates from the \SETUPKIT\KITFIL32\SYS32 directory. If those DLL files are not the 
versions specified above, you must replace the files with the specified versions.

Redistributing with International Applications

If you are redistributing a Tab Pro 32-bit ActiveX control with an international application, include the following files
in addition to the preceding files as appropriate:
File Description
MFC40CHS.DLL Chinese 
MFC40DEU.DLL German 
MFC40ESP.DLL Spanish 
MFC40FRA.DLL French 
MFC40ITA.DLL Italian 
MFC40JAP.DLL Japanese 
MFC40KOR.DLL Korean 

DLL Controls

To redistribute Tab Pro 32-bit DLL controls, include the following files: 
File Description
IMP32D30.DLL
TAB32D30.DLL

Tab Pro Imprint 32-bit DLL control
Tab Pro Tab 32-bit DLL control

Trial Information

The trial installation provides you with a 30-day trial version of Tab Pro. After you install the trial version, you may 



use it for up to 30 days. The time remaining in the trial period is displayed each time you use one of the Tab Pro 
controls in a project.

The trial version installs the following portions of Tab Pro:
ActiveX controls
Header files
Property pages
Online help
Samples for ActiveX controls
Additional explanatory files

You can purchase Tab Pro at any time by choosing the Purchase button found on the trial screen or the About Box
screen. Follow the instructions provided to contact FarPoint Technologies. Your order is processed while you wait.
After your order is processed, you will be given a serial number that will unlock the trial software immediately, 
giving you a fully licensed version of Tab Pro. This unlocking capability is made possible by our proprietary 
SoftwareSecure ™ technology.

After you purchase Tab Pro, you can reinstall the product (instructions) and install the following portions:
DLL controls
DLL library files
Samples for the DLL controls
User's Guide (PDF version)

If you decide not to purchase Tab Pro, we recommend that you uninstall the trial version from your system. To do 
so, run UNWISE.EXE from the \TABPRO30 directory on your system.

Caution If you have created projects using the trial version, after the trial version expires if you do not uninstall 
the trial version you cannot open those projects. To open projects containing expired trial versions of Tab 
Pro controls, you must uninstall Tab Pro from your system, and then open your project. If you intend to 
purchase Tab Pro, however, we recommend that you do not open your project until after you purchase 
and install Tab Pro so as not to lose any settings you set at design time for Tab Pro controls.

Important Note for Visual C++ Developers

If you use the trial version of Tab Pro in projects in Visual C++ and then purchase the licensed version of Tab Pro, 
you must perform the following steps to use the licensed controls in your existing projects:

1. Install the licensed version of Tab Pro on your system.

2. Open your project in Visual C++.

3. Select the Tab Pro control in your dialog and cut it to the Clipboard to preserve its property settings.

4. Paste the control back into your dialog.

5. Perform steps 3 and 4 for each Tab Pro control on dialogs in your project.

6. Save your project.

You must perform these steps to update the licensing information that is saved with your project at the time you 
originally created it. If you do not perform these steps, your project will not recognize that you are now using 
licensed versions of the controls.



Troubleshooting

I'm having problems installing the product. What do I do? 

How do I redistribute the Tab Pro control with my application? 

I've used the trial version, and now I would like to purchase TabPro. What do I do? 

How do I upgrade from previous versions of Tab Pro to Tab Pro version 3.0? 

What files does Tab Pro install on my machine? 

I am using Windows NT and received a message about access privileges. What does it mean?

My trial version has expired. What do I do? 



Windows NT access privileges message

If you are using Windows NT and received a message about access privileges, you do not have sufficient access 
privileges to modify the SoftwareSecure license information.

You are attempting to modify SoftwareSecure license information, and this product was installed by someone with
higher access privileges. (Modifications consist of installing maintenance releases, updates, upgrades, or licensed
versions of the product after initially installing the trial version of the product.)

To remedy this situation, have the person who initially installed this product (or someone with the same access 
privileges as the person who installed it) attempt to perform the task you just tried. If that person receives the 
same message, contact FarPoint Technologies' Technical Support department at (919) 460-1887 between the 
hours of 9:00 a.m. and 5:30 p.m. eastern time, Monday through Friday.



Purchasing Tab Pro

1. Go to the license screen or the About box for Tab Pro and click Purchase.

2. Call our Sales Department at (800) 645-5913 or (919) 460-4551 between 9 a.m. and 5:30 p.m. eastern time, 
Monday through Friday, to place your order.

Your order is processed while you wait. After your order is processed, you will be given a serial number that 
will unlock the trial software, giving you a fully licensed version of Tab Pro.

3. Type the serial number in the field provided, then click OK to continue.

4. If you want to use the DLL controls or the PDF version of the User's Guide, you must reinstall Tab Pro and 
choose those items from the Select Components to Install dialog.



Problems with installation

Be sure that you are following the appropriate instructions provided in Installing Tab Pro. Separate instructions are
provided depending on how your received the product and which operating environment you are using.

If you are installing a licensed version of the product, make sure that you have entered the correct Product Key 
and Serial Number. Type the Product Key and Serial Number in the provided fields exactly as they are provided to
you, including all punctuation and using uppercase or lowercase letters as appropriate.

If you continue to have problems, contact our Technical Support department at (919) 460-1887 between the hours
of 9:00 a.m. and 5:30 p.m. eastern time, Monday through Friday.



Trial version expired

If you have installed a trial version of Tab Pro and the trial has expired, you can purchase Tab Pro and unlock your
trial version by following the instructions in Purchasing Tab Pro.

If you have decided not to purchase Tab Pro, we recommend that you uninstall the trial version from your system. 
To do so, run UNWISE.EXE from the \TABPRO30 directory on your system.

Caution If you have created projects using the trial version, after the trial version expires if you do not uninstall 
the trial version you cannot open those projects. To open projects containing expired trial versions of Tab 
Pro controls, you must uninstall Tab Pro from your system, and then open your project. If you intend to 
purchase Tab Pro, however, we recommend that you do not open your project until after you purchase 
and install Tab Pro so as not to lose any settings you set at design time for Tab Pro controls.



To install Tab Pro from a downloaded trial version

1. Unzip the distribution file (TPTRIAL.ZIP) into a temporary directory.

2. Choose the Start button.

3. Choose Run and type
[drive]:\[directory]\SETUP.EXE
designating the temporary directory used in step 1.

4. Follow the instructions on the screen.



To install Tab Pro from the FarPoint Products CD 

1. Place the compact disc in the drive.

2. If the CD does not autostart on your system, run FPDEMO32.EXE.

3. Choose Install.

4. Do one of the following.

· If you are installing the licensed version of Tab Pro, type your Product Key and Serial Number in the 
fields provided, then click Install.

· If you are installing the trial version of Tab Pro, click Install.

5. Follow the instructions on the screen to complete the licensed or the trial installation.



To install Tab Pro manually from the FarPoint Products CD

1. Place the compact disc in the drive.

2. Choose the Start button.

3. Choose Run and type
[drive]:\PRODUCTS\TABPRO\SETUP.EXE
designating the drive containing the compact disc.

4. Follow the instructions on the screen to complete the licensed or trial installation.



Tab Pro 1.x VBX to Tab Pro 3.0 ActiveX (DAO) in Visual Basic

If you formerly used Tab Pro version 1.x or later VBX controls and now want to use Tab Pro version 3.0 ActiveX 
controls, complete the following steps:

1. If your existing project and form files have been saved as text, proceed to step 2. If they have not been saved
as text, open them in Visual Basic 3.0 or 4.0 (16-bit) and change the project setting to save them as text. 
Save them, and then close Visual Basic.

2. Open your project file (.MAK or .VBP) in a text editor and if the project used the file TABPRO11.BAS, change 
the path to use the version 3.0 TABPRO.BAS file instead. If you chose the default installation, the 
TABPRO.BAS file is in \Program Files\TABPRO30\INCLUDE.

When finished, save your changes and close the project file.

3. Open your form files (.FRM) in a text editor and change the following references, if present:
Change . . . To . . .
fpVBTabPro11 vaTabPro
fpVBImprintPro11 vaImprint
When finished, save your changes and close the form files.

3. Start Visual Basic 4 (32-bit), Visual Basic 5, or Visual Basic 6 and open your project file.

4. When the Custom Control Upgrade dialog prompts you to upgrade the TABPRO11.VBX or IMPPRO11.VBX, 
choose the OK button.

5. Respond to the Visual Basic messages. When prompted that your project will be saved to the newer version 
of Visual Basic, choose OK.

6. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.



Tab/VBX VBX to Tab Pro 3.0 ActiveX (DAO) in Visual Basic

If you formerly used the Tab/VBX VBX controls and now want to use Tab Pro version 3.0 ActiveX controls, 
complete the following steps:

1. If your existing project and form files have been saved as text, proceed to step 2. If they have not been saved
as text, open them in Visual Basic 3.0 or 4.0 (16-bit) and change the project setting to save them as text. 
Save them, and then close Visual Basic.

2. Open your project file (.MAK or .VBP) in a text editor and if the project used the file TABVBX11.BAS, change 
the path to use the version 3.0 TABPRO.BAS file instead. If you chose the default installation, the 
TABPRO.BAS file is in \Program Files\TABPRO30\INCLUDE.

When finished, save your changes and close the project file.

3. Open your form files (.FRM) in a text editor and change the following references, if present:
Change . . . To . . .
TabCtl vaTabPro
fpVbImprint vaImprint
When finished, save your changes and close the form files.

4. Start Visual Basic 4 (32-bit), Visual Basic 5, or Visual Basic 6 and open your project file.

5. When the Custom Control Upgrade dialog prompts you to upgrade the FPTAB11.VBX or FPIMPRNT11.VBX, 
choose the OK button.

6. Respond to the Visual Basic messages. When prompted that your project will be saved to the newer version 
of Visual Basic, choose OK.

7. Review the information in New Features in Tab Pro 3.0 to determine if you want to update settings in your 
project.




